28Non-ThinManager
Components

Microsoft Terminal Servers play an important role in the ThinManager system. It is recommended that you
become familiar with the documentation provided by Microsoft about their server. The following
information is provided as an aid to understanding terminal services and is not a substitute for Microsoft
documentation.

Microsoft Terminal Services requires a license, either a TS CAL (Terminal Services Client Access
License) on a 2003 Server or a RDS CAL (Remote Desktop Services Client Access License) on a 2008
Server.

This section covers:
e Server 2003
e Server 2008
e DHCP (Dynamic Host Configuration Protocol) Servers

e Terminal Services Licensing

28.1 Windows Server 2003

28.1.1 Installing Terminal Services

A Windows 2003 Server can be made a terminal server by installing the Terminal Services role. This can
be done with either the Manage Your Server or through the Add/Remove Programs > Add/Remove
Windows Components.
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t Manage Your Server

-| Manage Your Server
4

Server:TM

Search Help and Supp

% Managing Your Server Roles

Use the tools and information found here to add or remove
roles and perform your daily administrative tasks.

Your server has been configured with the following roles:

¥ File Server

# Terminal Server

Mo Terminal Services License Server was found on the
network, This terminal server will stop issuing temporary
licenses to dients 120 days after it receives the first
connection. Review licensing requirements for more
information.

The use of Internet Explorer is not restricted on this
server, For information on how to increase security, dick
the Internet Explorer Enhanced Security Configuration
link in the Tools and Updates section,

[+ Don't display this page at logon

Add or remove a role

o Read about server roles
o Read about remote
administration

) Review licensing
requirements

Open Terminal Services
Configuration

Open Terminal Services
Manager

€) Review the next steps for
this role

Tools and Updates

Administrative Tools
More Tools
Windows Update

Computer and Domain Mame
Information

Internet Explorer Enhanced
Security Configuration

See Also

Help and Support
Microsoft TechMet
Deployment and Resource Kits

List of Common Administrative
Tasks

Windows Server Communities
What's Mew

Strategic Technology Protection
Program

Manager Your Server

Select the Add or remove a role link on the Manager Your Server splash screen to install the Terminal
Services role and/or the Terminal Services License Server role.
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Windows Components Wizard

Windows Components
“'ou can add or remove components of Windows.

Tao add or remave a companent, click the checkbox. & shaded box means that anly
part of the component will be inztalled. To zee what's included in a companent, click
Dretailz.

Compaonents:
O Subszyztem for UMIX-bazed Applications 1.2 B ;I
0.0 MB
0.7 B

Terminal Server
O g Terminal Server Licenzing

) o
[ &2 UDDI Services 4.9 ME
[ =11 Indate: Pant Cerbficates nnwe T
Dezcnption: Configures this computer to allow multiple uzers to run one or mare
applications remately.
Tatal dizk stpan::e requ_lred: 4.0 MB Details,. |
Space available on dizk: 22122 MB

< Back I Mext » I Cancel | Helm |

Windows Component Wizard

Terminal Services can be installed by selecting the Terminal Server checkbox in the Windows
Component Wizard.

The Windows Component Wizard is launched by selecting the Add/Remove Windows Component
button on Control Panel > Add/Remove Programs.

Each Microsoft terminal server system will need a Microsoft Terminal Server Licensing server install. This
doesn’t have to be a separate computer but is a program installed on an existing computer. It is installed
by selecting the Terminal Server Licensing checkbox on the Windows Component Wizard.

See Microsoft Licenses for details.
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28.2 Creating Microsoft User Profiles

A terminal needs a valid Windows User Profiles to log onto a terminal server.

Open the Computer Management Console by selecting Start > Administrative Tools > Computer
Management in Windows 2003/2008 to create a user profile.

Q File  Action Mew findow  Help |;|i|5|
& - | BRI ®
Q Computer Management {Local) Name | Full Marne | Description
Elﬁ& Systern Tools Eadminl
@ Ewent Yiewer 7 admin10
&g Shared Folders 7 admin11
=¥ Local Users and Groups }ﬁadmian
a St 7 admin13

}ﬁadminm

+- 3 Performance Logs and Alert: jﬁadminlS

B Device Managet - )
Shorage éﬁﬂdmlnE
{23 Remavable Starage gadm!m
L Disk Defragmenter : adm!nt}
- Disk Management {'ﬁﬂdmlﬁ
]@ Services and Applications éﬁadmlnﬁ

ﬁ adrnin?
ﬂadminﬂ
jfﬁadming

}ﬁ,ﬁ,dministratgr Built-in account For adminiskering kF

a1 | o] |

Computer Management Console

Highlight the User sub-folder of Local Users and Groups in the Computer Management tree pane.
Select Action > New User. This will launch a New User dialog box.
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hewvser g

Lzer name: I

Eull harme: I

Description: I

Pazsword: I

Confirm pazsword: I

¥ User must change password at next logon
™| Uger cannot change passwaord

[T Fassword neven expires

[T Account is disabled

[Create I Cloze

New User Dialog

Enter the user name for the user in the User name field.

Enter a password in the Password field.

Re-enter the password in the Confirm password field.

The User must change password at next logon check box forces the user to change the password.
Select the Create button to finish the profile.

Select the Close button to return to the Computer Management Console.

Note: Users need to be added to the Remote Desktop Users group or the Administrators group to be
allowed to connect to a terminal server.
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28.3 Software Installation On Windows 2003

Microsoft Windows 2003/Server requires that software be added in the “Install Mode” through the
Control Panel > Add/Remove Programs.

Select Start > Settings > Control Panel > Add/Remove Programs to launch the Add/Remove
Programs dialog box.

Note: Some software, especially downloaded software, doesn’t allow the installer to install it through the
Add/Remove Programs tools. To manually put the machine into the install mode open a command prompt
and type:

change user /install

This command sets the machine to install mode. When finished, type:

change user /execute

This command returns the machine to the normal run mode.

Fj'g Add/Remove Programs H=] B3

add a program Fram CO-ROM or Floppy disk,
To add a program from a CO-ROM or Floppy disk, click CD or Floppy, D ar Eloppy |

Add programs From Microsaft

To add new Windows Features, device drivers, and syskem updates wind Undat |
a over the Internet, click wWindows Update, NERNE SRERE

Programs

Close |

Add/Remove Programs

Select the CD or Floppy button on the Add/Remove Programs dialog box to open the Installation
wizard.
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Install Program From Floppy Disk or CD-ROM

Inzert the product's first installation floppy digk or CO-ROM,
and then click Mext.

Cancel

Install Program Window

The wizard will prompt for the installation of the software disk. Select Next to display the Run Installation
Program dialog box.

Note: If the new program starts in autorun and proceeds without going through the following procedures,
either stop the autorun and use the wizard to initiate the installation, or use the change user
/install command to place the machine in the install mode. Use the change user /execute
command when finished to return the machine to the Run mode.

Run Installation Program

Windaws waz unable to find the installation program. Click
Back to try again. Click Browsze to find the inztallation
prograrm marially.

Oper:

|| Browse...

| < Back | Cancel

Run Installation Program
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Enter the command line of the installation program and select Finish, or select the Browse button to
select the installation file.

i s

ACROBAT [ wfu
bootagnt Cwingx
dmi-snmp ﬁsetup.exe
dos

info

Idcrm

makedisk,

MWSErer

052

Livoli

unix;

Cancel

File harne: I j Open
=

Files of type: ISetup Programs

It

Browse File Window

Selecting the Browse button on the Run Installation dialog box will launch a Browse File window.
Highlight the installation file and select Open. This will begin the application setup.

After Installation x|

After installation, pleaze click Next.

< Back Cancel

After Installation Window

As the installation begins, an After Installation dialog box is displayed. It requests that the Next button
be selected when the installation is finished. When this button is selected a second confirmation window
is displayed.
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Finish Admin Install x|

When the ingtallation has ended [successfully or not),
pleaze click the Finizh button or the Cancel button. DO
MOT CLICK, THE BUTTOMS BEFORE INSTALLATION
Ha&S ERDED!

< Back {Fiish Cancel

Finish Install Window

Select the Finish button when the installation is finished.

Note: If a choice is given to Reboot Now or Reboot Later, choose to reboot later once the entire setup is
completed and the dialog boxes are cleared.

28.3.1 Terminal Services Configuration

Microsoft provides the Terminal Services Configuration interface to configure how terminal services is
handled on each terminal server.

Select Start > Programs > Administrative Tools > Terminal Services Configuration to launch the
Terminal Services Configuration Console. There are two folders, Connections and Server Settings.

28.3.2 Terminal Services Connections

The Terminal Services Configuration tree has a Connections folder. Highlighting this folder will display
the installed client communication protocols.
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tscc - [Terminal Services Configuration', Connections]

File  Action  Yew Help

= | EE DR @ E

,, Terminal Services Configuration
a Connections

------ [C] Server Settings

Conneckion

| Transpark

| Type

| Carment |

=2RDP-Tcp

tcp

Micrasaoft ROP 5.2

Terminal Services Configuration\\Connections Console - Connections

Double clicking on the RDP-tcp icon on the right will launch the RDP-tcp Properties
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28.3.2.1 RDP-tcp Login Settings
ROP-TcpProperties @R

Femate Control | Client Settings | Hetwork Adapter I Permizzions
General Logon Settings | Sezsionz I Erviranmment

&% Usze client-provided logon information

" Always use the following logon information:

zer mame:

[amait

Fazzword; I

Eatfirm passwornd;

[T ahways prompt for passwerd

O, I Cancel Apply

RDP-tcp Login Settings

The Login Settings should use the Use client-provided logon information radio button so that each
user will login with a unique account.

The Always prompt for password should be unselected to allow auto-logins.
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28.3.2.2 RDP-tcp Sessions Settings
ROP-TcpProperties @R

Femate Control I Client Settings l Hetwork Adapter I Permizzions
General I Logon Settingz Session: | E nvironment

Ize thiz tab ta zet Teminal Services timeout and reconnection settings.

™ Ovenide user settings

End a dizconnected sessian; INever j

Aotive zezsian limik; INever

Lef L

|dle zezsion limit: INever

[ Owveride user settings
YWhen seszsion limit iz reached or connection is broken:
£ Dizconnect fram session

£ End session

™| Oweride user zettings
Allowe reconnection:

% From any client

€ From previous client

Cancel Apply

Individual User Account Sessions Configuration

Each user account can be configured individually in the Computer Management interface. These can be
set to end a disconnected session or an idle session after a period of time. The Terminal Services
Configuration Console allows these settings to be made for every user of the terminal server, speeding
configuration time.
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RDP-Tcp Properties ﬂ E |

Remaote Cantral I Client Settings l M etwork Adapher I Permizsions

General I Logon Settings Sessiang

Iz this tab to zet Terminal Services tmeout and reconnection settings.

E nvironment

¥ ‘Ovenide user settings

End a disconnected session: I1 mirute |
Active zezsion limit; INever j
|dle zezzion limit: INever j

¥ Owveride user settings

YWhen seszsion limit iz reached or connection is broken:

" Dizconnect from session

£+ End session

™| Oweride user zettings
Allowe reconnection:

% From any client

€ From previous client

0k, I Cancel

apply

RDP-tcp Sessions Settings

The Sessions tab of the RDP-tcp Properties allows all users to be configured with a consistent
disconnect policy by selecting the Override user settings checkbox.

Selecting End Session setting for the When session limit is reached or connection is broken and
selecting the Override user settings will cause a new session to be created when a terminal disconnects

and reconnects.
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28.3.2.3 RDP-tcp Client Settings
ROP-TcpProperties @R

General I Logon Settings | Sezzionz I E rvironment
Remate Contral Clignt Settings I Metwork Adapter I Permissions

— Connechion

¥ Use connection zettings from uzer settings
¥ | Connect client dives atlogon
¥ Connect client printers at logon

¥ | Default to main client printer

¥ Limit Maximum Color Depth

|16 it 4

Dizable the following:

[ Dvive mapping [~ COM port mapping
[T “wWindows printer mapping [” Clipboard mapping

[ LPT port mapping

O, I Cancel Apply

RDP-tcp Client Settings

The Client Settings tab of the RDP-tcp Properties allows the color depth to be set in the Limit Maximum
Color Depth drop-down.

Drive mapping, LPT port mapping, COM port mapping, and audio mapping are allowed if the appropriate
Disable the following checkboxes are un-selected.

Audio mapping is disabled by default. You need to uncheck the Audio mapping checkbox to allow a thin
client to play sound.
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28.3.2.4 RDP-tcp Network Adapter Settings

RDP-Tcp Properties ﬂ E |

General I Logon Settings | Sezgionz | E rvironment
Remate Contral I Client Settings Metwork Adapter | Permissions

The following network. adapters are compatible with the zelected transport
tupe. Select the netwark, adapter you want ta Lze.

Hetwork adapter:

All netwark, adapters configured with this protocal j

™ Unlimited connections

% b auimum conmections: 1a :I

O, I Cancel Apply

RDP-tcp Network Adapter Settings

The Network Adapter tab of the RDP-tcp Properties can be used to limit the number of active users to
aid in application licensing compliance.

28.3.3 Terminal Services Connections

The Terminal Services Configuration tree has a Connections folder. Highlighting this folder will display
the installed client communication protocols.
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tscc - [Terminal Services Configuration' Server Settings]

File Action  Yew Help

== | aE DR @ E

,, Terminal Services Configuration Settings | attribute |
-+ Connections %] Delete temporary Folders on exit Yes
o | oerver Settings Llse kemporary Folders per session Wes
Licensing Per Device
F'.I:I:ive Desktop Disable
Permissien Cornpatibility Relaxed Secority
Restrin:t each user ko one session Wes
License server discovery rmode Automatic

Terminal Services Configuration\\Connections Console - Connections

The Server Settings have several settings that can control the terminal services experience.

28.3.4 Licensing Mode

Microsoft expanded the Terminal Services Client Access License (TS CAL) program in Windows 2003.
TS CALs are available in two types, TS Device CALs and TS User CALs.

e The TS Device CAL licenses one device to connect to any Microsoft Terminal Servers as any
user. This functions like the previous Windows 2000 TS CAL.

e The TS User CAL licenses one user for any device to connect to any Microsoft Terminal
Servers.

To change between the Per Device licensing and Per User licensing, double-click Licensing to launch
the Licensing Mode window.
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icensngMode K|

Licensing Maode: IP'E" Device j

Thiz policy requires a licenze to be izzued to each client computer
[device] that connects to the terminal server.

To change thig gerver to Bemate Desktop for Administration, use Adds
Bermowve Programs.

ak I Cancel

Terminal Services Configuration Console- Licensing Mode

Select the desired mode from the Licensing Mode dropdown box and click OK.

28.3.5 Permission Compatibility

Microsoft has increased the security in each successive release of its terminal server software. These
new policies prevent users from accessing the system folder, *.ini files, the registry, and other resources.
Some programs such as HMI, SCADA, database, and control software need access to these resources
to function. Instead of making all the users administrators, the security can be set to the less strenuous
Windows NT 4.0-style security.

Permission Compatibility |

Some applications require special access o system resources, such as the registry and
gystemn directones, in order to work, correctly.

" Full Security

Select thiz option to provide the mozt secure environment in which ta run applications. By
default, Terminal Server Uzers will have the same permissions as members of the Uzers
araup and thug may nat be able to run 2aome legacy applications.

Select thiz option if you have compatibility problems with legacy applications.

& IInder this configuration, all Uzers will have full access to critical registry and
file zystem locations. This may be neceszany in order to win many legacy

applications.
OF. I Canizel

Terminal Services Configuration Console- Permission Compatibility

Launch the Permission Compatibility window by double-clicking on the Permission Compatibility
setting. Select the Relaxed Security radio button and select the OK button.
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28.3.6 Restrict Each User to a Single Session

The Restrict Each User to a Single Session setting prevents duplicate and orphaned sessions by
limiting each user to a single login.

Double-clicking the setting will launch a settings window.

Single session per user |

To conzerve zerver resources and simplify reconnecting to
dizconnected sessions, you can restrict each uzer to a zingle
zEzsion

v Bestrict each uzer bo ane sessior

ak. I Carnicel

Terminal Services Configuration Console- Single Session Per User

The Restrict each user to one session checkbox is selected by default in Windows 2003.

Note: Keep this setting selected. MultiSession will still work as long as each session is using a different
AppLink program.

28.3.7 License Server Discovery Mode

A new feature in Windows 2003, Service Pack 1 and later, is a setting to point the terminal server to a
specific Terminal Server Licensing Server. This is the License server discovery mode setting in
Terminal Services Configuration. This is easier than hard coding the license server into the registry.
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Terminal Server License Server discovery n |

— Licenze server dizcoveny method

i~ Automatic

% Usze theze license servers:

|1 92.168.1.34 Check names |

Thiz Terminal Server will attempt ta lacate theze licenze servers firzt, |f they are nok
lozated, thiz Terminal Server will attempt automatic dizcoveny.

Separate licenze server names with commas.

Ewxample: Serverl, Servers example.com, 192.168.1.1

—Automatically discovered license servers

I DomainSefork.group role: I

In Enterprize role: I

Cancel | ] I

Terminal Server License Server Discovery Window

Launch the Terminal Server License Server Discovery Window by double-clicking the License server
discovery mode setting in Terminal Services Configuration window.

Entering a valid Microsoft Terminal Server Licensing Server name in the Use these license servers field
will force the terminal server to use the defined server as the license server. This keeps the terminal
server from getting confused when there are multiple license servers.

The Automatically discovered license servers field would be automatically populated with license
servers found by the terminal server and can be used as a reference. The Check names button will
check the validation of the name in the Use these license servers field.
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28.4 Windows 2008 Server

28.4.1 Adding Terminal Server Role

Windows 2008 Server, like Windows 2003 Server, allows two RDP connections for administrative
purposes. To make the Windows 2008 Server a terminal server where many people can access
applications requires adding the Terminal Services Role.

Open the Server Manager window.

-ﬁ Server Manager E\@

File Action View Help
@& =|2E)
=k Server Manager (WIN2008R2) Roles
s i\ Roles
» @& Features
» 3 Diagnostics
>} Configuration

$ View the health of the roles installed on your server and add or remove roles and features,

| »

> Euj Storage
~! Roles Summary Reles Summary Help

m

~) Roles: 1 of 17 installed 3{_5 Add Roles

_‘531'. Remove Roles
Web Server (IS}

~) Web Server (IIS) Web Server (IIS) Help

Provides a reliable, manageable, and scalable Web application infrastructure.

~) Role Status [F Go to Web Server (IIS)

Messages: None
Systern Services: 4 Running, 1 Stopped
Events: None in the last 24 hours

Best Practices Analyzer: To start a Best Practices
Analyzer scan, go to the Best Practices Analyzer i

tila am thic rnla's harnanane and cliclk S-an thic

5:: Last Refresh: Today at 3:01 PM Cenfigure refresh

Server Manager Window

Highlight Roles in the tree and select Add Roles in the right pane. A wizard will launch allowing you to
add Terminal Services as a role.

Highlights of the Role Wizard include:
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Add Roles Wizard

Before You Begin

Remote Desktop Services
Role Services

Coenfirmation

Progress

Results

Select Server Roles

Select one or more roles to install on this server,

Roles:

Description:

[] Active Directory Certificate Services
[[] Active Directory Domain Services
[] Active Directory Federation Services
[] Active Directory Lightweight Directory Services
[] Active Directory Rights Management Services
[] Application Server
[] DHCP Server
[] DNS Server
[] Fax Server
[] File Services
[] Hyper-v
[ Metwerk Policy and Access Services
[] Print and Document Services
Remote Desktop Services
Web Server (I5) (Installed)
[] Windews Deployment Services
[] Windows Server Update Services

Remote Desktop Services,
formerly Terminal Services,
provides technelegies that enable
users to access Windows-based
pregrams that are installed on an
RD Session Host senver or to
access the full Windows desktop.
With Remote Desktop Services,

users can access an RD Session
Host server or virtual machine
from within your corporate
network or from the Internet.

More about server reles

< Prewious ” Mext =

Cancel

Role Wizard - Select Server Roles

The Role Wizard lists a dozen roles that are available.

Check the Remote Desktop Services (or Terminal Services) checkbox and any other roles desired.

Select Next to continue.
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Add Roles Wizard (23]

Select Role Services

e Select the role services to install for Remote Desktop Services:

Server Roles Role services: Description:
Remote Desktop Services T e Remote Desktop Session Host
- N . - 1 N i
[] Remote Desktop Virtualization Host (RD Session Hosl), formerly

Terminal Server, enables a server

Application Compatibility [[] Remote Desktop Licensing O L s P
Authentication Method [] Rernote Desktop Connection Broker or the full Windows desktop.
oo o [] Remote Desktop Gateway Users can connect to an RD

[ Remote Desktop Web Access Session Host server to run
User Groups programs, save files, and use
Client Experience network resources on that server.

Confirmation
Progress
Results

More about role services

< Prewious ” Mext =

Role Wizard —Select Role Services

Terminal Services has several options:
Terminal Server — the basic terminal services option. Check this option

TS Licensing — This makes the server a 2008 License Server.

You need a 2008 License Server and 2008 Terminal Services Client Access Licenses (TS
CALSs) to operate.

Select this if this server will be your Terminal Services License Server.

Select Next to continue.
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Add Roles Wizard

Before You Begin
Server Roles
Remote Desktop Services
Role Services
Application Compatibility
Authentication Method
User Groups
Client Experience
RD Licensing Configuration
Cenfirmation
Progress

Results

Specify Licensing Mode

The Remote Desktop licensing mode determines the type of Remote Desktop Services client access

licenses (RDS CALs) that a license server will issue to clients that connect to this RD Session Host
SEMVEF.

Specify the Remote Desktop licensing mode that ywou want this RD Session Host server to use,
) Configure later

Remind me to use the Remote Desktop Session Host Configuration tool or Group Policy to
cenfigure the licensing mode within the next 120 days.

(") Per Device

An RDS Per Device CAL must be available for each device that connects to this RD Session
Host zerver.

@ Per User

An RDS Per User CAL must be available for each user that connects to this RD Session Host
EEMVEr.

(ij The licensing mode that you specify must match the RDS CALs that are available from your
Remote Desktop license server.

More about the Remote Deslktop licensing mode

[ < Prewious ” Mext =

Role Wizard — Specify Licensing Mode

Windows 2008 TS CALs, like Windows 2003 TS CALs, are available as Per Device or Per User.
The terminal server should match the mode that the license server is using.

Select Next to continue.
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Add Roles Wizard (23]

Confirm Installation Selections

Before You Begin

To install the following roles, role services, or features, click Install.
Server Roles

Remote Desktop Services /% 1warning, 2 informational messages below

Role Services 3

'i!:' This server must be restarted after the installation completes,
Application Compatibility
o | Remote Desktop Services
Authentication Method

Remote Desktop Session Host

Licensing Mode /A You may need to reinstall existing applications.

SEEIELE ':i:' IE Enhanced Security Configuration will be turned off.

Client Experience Authentication method Do not require Network Level Authentication
RD Licensing Configuration Licensing mode: Per uzer
Groups allowed access : Adrministrators, userl (WIN2008R2\userl)
Audio and video playback : Disabled
Progress . . . . .
Audio recording redirection : Disabled
Resuilts Desktop composition : Disabled
RD Licensing
Availability : This warkgraup
Database path: CAWindows\system324LServer

Print, e-mail, or sawve this information

Install l ’ Cancel

Role Wizard — Confirm Installation Selections
The Add Roles Wizard will end with a list of the configurations that will be installed.

Select Install to add the role(s). Once the wizard is finished it will assume the role of a terminal server.

546 e Non-ThinManager Components ACP ThinManager 6.0



28.4.2 Adding Applications in Windows 2008

Applications on terminal servers need to be installed in the Install Mode. Open the Control Panel and
click on the Install Application on Terminal Server icon to start the installation wizard.

Install
Application on
Terminal
Server

Install Application on Terminal Server Icon
A wizard will run that allows the installation of the application.

The Install Mode can also be entered by typing change user /install atacommand prompt.
You can then run the Setup - exe to install your application.

Type change user /execute when finished installing to leave the Install Mode.
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28.4.3 Create Users

Users management is located in the Server Manager console.

A Cornputer Management EI@

File Action View Help
&= E = HE

.S (;DmputerManagement(Local Mame Description * || Actions
4 ff} System Tools

+ ((5) Task Scheduler

> E Event Viewer

> [z Shared Folders

a e |ocal Users and Groups

& Administrators Administrators have complete an... Groups -
e Backup O perators Backup Operators can override se... Mare Actions »
el Certificate Service DC...  Members of this group are allowe...
;;&_‘ Cryptographic Operat.. Members are authorized to perfor...
¥ Distributed COM Users  Members are allowed to launch, a...

| Users
= Groups #¥ Event Log Readers Mermbers of this group can read e..
¥ F‘_erfnrmance P Guests Guests have the same access as m...
_Jé Device Manager J2 TS TUSRS Built-in group used by Internet Inf..,
4 22 storage & Network Configuratio.. Members in this group can have s...
L=} Disk Management & Performance Log Users  Members of this group may sche... E
s :: Services and Applications B performance Menitor ... Members of this group can acces...
H Power Users Powier Users are included for back...
#‘_‘ Print Operators Members can administer domain ..
J= Remote Desktop Users  Members in this group are grante...
5 p group are g
J= Replicator Supports file replication in a dom...
5 hep PP p
P Users Users are prevented from making ...
5 p g

= HelpLibraryUpdaters

% 50QL5erver20055QLEro... Members in the group have the re...
H SQLServerMSSQLServ...  Members in the group have the re...
Pl sl ServerMSSQLUser..  Members in the group have the re..,
P S0l serverSQLAgentl... Members in the group have the re..,
- & ThinManager Shadow..,

il To AR A oo A e Bl e oL Rleie comeiim mmem emm = oliE

Server Manager — Local Users and Groups

Users need to be members of the Remote Desktop Users group to access the terminal server.

28.4.4 Allowing Application Access

Applications installed on a terminal server are not available to remote users unless the Terminal Server
Settings are changed to allow access to the applications. You can either allow access to all applications
or allow access to specific applications in the TS RemoteApp Manager.

28.4.4.1 Allowing Application Access — All Applications

Applications installed on a terminal server are not available to remote users unless the Terminal Server
Settings are changed to allow access to the applications.

You can change the settings to allow access to all installed applications in the TS RemoteApp Manager.
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E_,= Server Manager

S [=]
File Action \View Help
&= %5
i-a A QLB S TS RemoteApp Manager (2008TSE49) Actions
=l 3 Roles -7
a8 . ' a || TS RemoteApp Manager (... =
&l &5 Terminal Services TS RemoteApp Manager = | e
a TS RemoteApp Ma RemoteApp programs are programs that are access [ Add RemoteApp Programs
Terminal Services C ( i appear as if they are running on the client's local o = ) )
=1 Terminal Services M R mn RemoteApp program available to users, you must & Terminal Server Settings
il Features El T Gateway Settings
& Diagnostics B Diital S )
= Cigital 5 ture Setti
jﬂﬂ Configuration PO igital Signature Settings
{24 storage 3 Export RemoteApp Setti...
| Terminal Server Settings| Change ?Et'[r}:t % Import RemoteApp Setti...
A0 The
(i) Clients will connect to: 2008TSE49 e View v
/0 Users can start listed and unlisted uni 7 |
programs on initial connection. s Al . He
¥
T5 Gateway Settings Change We
(D Clients will use T5 Gateway settings @ Ar
defined by their domain's Group Policy. el
Chiz
Digital Signature Settings Change
/0 Mo digital certificate is configured. (Using .ﬁ. tlc
a digital certificate may improve security.)
RDP Settings Change Other
(D Clients will not use any custorm ROP SEIE.Ct
settings. option
Cre
3 I
| | 3 ) K1 |

’
|

TS RemoteApp Manager

Highlight TS RemoteApp Manager under the Terminal Services branch of the Server Manager tree.

Select the Change link for the Terminal Server Settings to launch the RemoteApp Deployment
Settings page.
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RemoteApp Deployment Settings

Comman RDP Settings I Custom RDP Settings
Teminal Server | TS Gateway I Cigital Signature

Clients will use these settings while connecting to this teminal server.

—Connection settings

Server name: |2008TSE4S

ff the terminal serveris in a fam, enterthe DNS name of the
fam.

BDF port: 3389

v Require server authentication

If you use server authentication, you may have to provide a fully qualified DNS
name in the Server name boo.

— Remote desktop access

™ Show aremote deshktop connection to this terminal serverin TS Web Access

— Access to unlisted programs

™ Do not allow users to start unlisted programes on initial connection
{Recommended)

* AMlow users to start both listed and unlisted programs on initial connection

QK Cancel Anphy

RemoteApp Deployment Settings

Select the Terminal Server tab of the RemoteApp Deployment Settings page.

Select the Allow users to start both listed and unlisted programs on initial connection radio button

in the Access to unlisted programs section.
This will allow any program to be run by an authorized user.

You can also select and define specific applications that can be run by configuring them in the TS

RemoteApp Manager.
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28.4.4.2

applications.

[, Server Manager

Fle Acton View Help

Allowing Application Access — Specific Applications
You can control application access on Windows 2008 Server by only allowing access to specific

IS[=] B3

ke A=l Eall 7 e

ia Server Manager (2008TSE49)
= ;j) Rales
=] ;ﬁ Terminal Services

TS RemoteApp Manager

TS5 RemoteApp Manager (2008TSE49)

Actions

TS RemoteApp Manager (2008TSE49)

-
o) %
TS RemoteApp Manage RemoteApp programs are programs that are accessed through Terminal Services, and | [E1] Add RemateApp Programs
Terminal Services Confi ( | appear as if they are running on the client's local computer, Before you can make a B Terminal Server Seth
=g Terminal Services Mana < ™ | RemoteApp program available to users, you must add it to the RemoteApp Programs list, =l TEIminalServer setings
Eﬂ Features i ﬂ TS Gateway Settings
_5‘- Diagnostics x . . .
= 33% Configuration S w0 5] Digital Signature Settings
9 Task Scheduler c4 Export RemoteApp Settings
Windows Firewall with Advz ; : istributi i -
H i W : z Terminal Server Settings Change D istribution with TS Web Access ] EE Import RemoteApp Settings
54 Services _ The TS Web Access Computers group is
& WMI Control @ Clients will connect to: 2008T5E49 empty. RemoteApp programs may be View »
= :E Local Users and Groups o/ Users can only start listed Remotedpp unavailable to users. Refresh | Learn more Hel
g T - - ) L elp
TI Users [Jrogram_- on initial connection, ,@, The Rematefpp Pragrams list is empty.
| Groups (Recommended)

Kg Storage @ A remote deskiop connection for this server

TS Gateway Settings Change is not visible in TS Web Access. Change

@ Clients will use T5 Gateway settings defined
by their domain's Group Policy.
Digital Signature Settings Change

'@' Meore about using TS Web Access

Other Distribution Options

Select a RemoteApp program and choose an
option below,

Create .rdp File

/0 Mo digital certificate is configured, (Using a
digital certificate may improve security.)
RDP Settings Change

@ Clients will not use any custom RDP

! Create Windows Installer Package
settings,

'@' More about distribution options

RemoteApp Programs

MName | Path | TS Web Acce.., | Arguments

TS RemoteApp Manager

Highlight TS RemoteApp Manager under the Terminal Services branch of the Server Manager tree.

Select the Add RemoteApp Programs link in the Actions column on the right of the screen to launch the
RemoteApp Wizard.
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RemoteApp Wizard

Choose programs to add to the RemoteApp Programs list

Select the programs that you want to add to the RemotefApp Programs list. You
can also configure individual RemoteApp properties, such as the icon to display.

Mame

HE;
mE
O
0e

Calculator

[iata Sources [ODBC)

Diisk; Defragmenter

iSCS| Inttiator

Memory Diagnostics Toal
Pairit

Pairt Shop Pro 5

Problem Reports and Solutions
Remate Desktop Connection
Securty Corfiguration Wizard
Server Manager

System Configuration

(] i System Information
[ Windows Contacts ;I
Select Al Select Mone Properties. .. | Browse... |
< Back Nest = Cancel |
RemoteApp Wizard

The RemoteApp Wizard shows a list of applications installed on the Windows 2008 Server.

Select the checkbox for each application that you want available for deployment as a ThinManager

Display Client.

Select Next to complete the wizard. A remote user can run any checked application.

28.4.5 Installing ThinManager

It is a common practice to install ThinManager on a terminal server but ThinManager is independent of
terminal services and doesn’t need to be installed on a terminal server.

Applications on terminal servers need to be installed in the Install Mode. Open the Control Panel and
click on the Install Application on Terminal Server icon to start the installation wizard.

»
Install
Application aon
Terminal
Server

Install Application on Terminal Server Icon

552 e Non-ThinManager Components

ACP ThinManager 6.0



Once the wizard begins navigate to the ThinManager setup.exe program and continue with the wizard.
See Installation of ThinManager for detalils.

The Install Mode can also be entered by typing change user /Zinstall at a command prompt.
You can then run the SetuUp . exe to install ThinManager.

Type change user /execute when finished installing to leave the Install Mode.

28.4.6 Allow Inbound Traffic to Firewall

ThinManager requires communications to the thin clients. This communication is blocked by default in the
firewall and needs to be allowed.

You can either open the firewall to all traffic or open the specific ports needed.

28.4.6.1 Allow All Inbound Traffic

You can configure the firewall by selecting Windows Firewall with Advanced Security in the Server
Manager tree.

File Action View Help

@& =|[E)  HE

¥ Windows Firewall with Advanced Security EI@

A A an=| Windows Firewall with Advanced Security on Local Computer Actions

i3 Inbound Rules + | Windows Firewall with Advance...

% Outbound Rules 3 , ) . i .
:_!: Connection Security Rules Windows Firewall with Advanced Security provides network security & Import Policy...

B Monitoring fa| ExportPolicy...
Overview Restorz Default Pclicy
Domain Profile Diagnose / Repair
b Windows Sirewall is off. = View
Private Profile i Refresh
& Windows Srewall is off. D Propetties
Public Profile is Aclive [ Help

"!;;’;" Windowe Sirewall ie off.

E] Windows =irewall Properties

Getting Started

Authenticate communications between computers

Create connecton security rules to specify how and when connections bet
pratected by usng Intemet Frotocal secuity {IFsec).

E] Connection Securty Rules

4 1] HIER mn 3

F Y

Windows Firewall with Advanced Security

Highlight Windows Firewall with Advanced Security in the Server Manager tree. Right click and select
Properties to launch the Properties window.
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i

Windows Firewall with Advanced Security on Local Cormputer Pro... @

Dornain Profile | Private: Profile | Public Profile | IPsec Settings |

Cpecify behavior for when a computer is connected to ts coporate
domain.

State

i P Firewall state: [Crﬁ v]
Block: {default)

Inbound connections:
Outbound connections: Allow (default)

Protected netwarlk comnections: Customize...

Settings

— Specify seﬁing_s that control Windows Customize.
“— | Firewall behaviar.

Logging
1 Specify logging settings for e

troubleshoating.

Leam more about these settings

Ok ] [ Cancel Apply

-

Windows Firewall with Advanced Security Properties

Change the Inbound connections to Allow and select OK to accept the change.

This will allow the thin clients to connect to ThinManager through the firewall.

Select the profile tab that matches the type of network you are using, Domain, Private, or Public profile.
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28.4.6.2

Open Ports in Firewall

You can open specific ports in the Windows 2008 Server firewall instead of allowing all inbound

connections if you prefer.

Open the Local Security Policy by selecting the Start > Administrative Tools > Local Security Policy.

Hle  Achion View  Help

o= 70 =z HE

0 Windows Firewzll with Advance
i3 Inbound Rules
Outbound Rules
2‘!__ Connection Security Rules

- B Menitoring

4 (L I

9 Windows Firewall with Advanced Security

Inbound Rules

Mame

@Micmsn& Office Outlock

@Micmsn& OneMote

@Micrnsnf‘t OneMote

@Micmsn& SharePoint Workspace
@Micmsn& SharePoint Workspace
.BranchCache Zontent Retrieval (HTTP-In)
.BranchCache Hosted Cache Server (FTT...
.BranchCache Peer Discovery (W5D-In)
.COM+ Metwork Access (COM-In)
.COM+ Remote Administration (DCOM-In)
@Ccre Metworkng - Destination Unreacha...
@Ccre Metworkng - Destination Unreacha...
@Ccre Metworking - Dynamic Host Config...
@Ccre Metworkng - Dynamic Hest Config...
@Ccre Metworkng - Internet Group Mzna...
@ Core Networking - IPHTT?S (TCP-In)

i@ Core Metworkng - IPvE (IPv-In)

@Ccre Metworkng - Multicast Listener Do...
@JCcre Metworkng - Multicast Listener Qu...
@Ccre Metworkng - Multicast Listener Rep...

4| n |

=5 e =X
Aclions
Group = + || Inbound Rules -
i3 MewRule..
=\||SF Filter by Profile 3
S Filter by State »
ST Filter by Group 3
BranchCache - Conter View »
BranchCache - Hostec
| i) Reflresh
BranchCache - Peer Di —
COM+ Network Acces = Exportlist..
COM+ Remote Admir Help
Core Metworking
Core Metworking
Core Networking
Core Metworking
Core Metworking
Core Networking
Core Metworking
Core Metworking
Core Networking
Core Metworking i

Local Security Policy

Expand the Windows Firewall with Advanced Security to show the Inbound Rules.

Right click on the Inbound Rules and select New Rule. A wizard will launch that allows configuration of a

new port.

You need to run the wizard twice, once to allow UDP 4900 and once to allow TCP 2031.
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s

ﬂ Mew Inbound Rule Wizard @

Rule Type
Select the type of firewall nule to create.

Steps:

» FRule Type What type of rule would you like to create?

@ Protocol and Ports

@ Action ) Program

@ Profile Rule that controls connections for a program.
@ MName @ Port

Rule that controls connections fora TCP or UDP port.
"' Predefined:
BranchCache - Content Retrigval (Uses HTTF)

Rule that controls connections for a Windows experience.

' Custom
Custom rule.

Leam more about nule types

< Back Mext = l [ Cancel

Rule Wizard — Rule Type

Select Port as the rule you are configuring and select Next to continue.
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s

ﬁ Mew Inbound Rule Wizard @

Protocol and Ports
Specify the protocols and ports to which this nule applies.

Steps:

& FRule Type Does this rule apphy to TCP or UDP?
# Protocol and Ports @ TCP

@ Action ) UDpP

@ Profile

@ MName

Does this rule apphy to all local ports or specific local ports?

All local ports

@ Specific local ports: 2031
BExample: 80, 443, 5000-5010

Leam more about protocol and ports

Rule Wizard — Protocols and Ports

You will need to select the protocol and port for each rule. You will need to run the wizard once for UDP
4900 and once for TCP 2031.

Select the protocol and enter the port as shown in Rule Wizard — Protocols and Ports.

Select Next to continue.
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s

ﬂ Mew Inbound Rule Wizard @
Action

Specify the action to be takeen when a connection matches the conditions specified in the rule.

Steps:

& FRule Type What action should be taleen when a connection matches the specified conditions?

@ Protocol and Ports )
@ Allow the connection

. E This includes connections that are protected with IPsec as well as those are not.
@ Prcfile )

| Allow the connection if it is secure
& Mame

This includes only connections that have been authenticated by using IPsec. Conmections
will be secured using the settings in IPsec properties and rules in the Connection Security
Fule node.

| Block the connection

Leam more about actions

Rule Wizard — Action

Select Allow the Connection.

Select Next to continue.
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s

ﬂ Mew Inbound Rule Wizard @
Profile
Specify the profiles for which this nule applies.

Steps:

@ Rule Type When does this ule apply?

& Protocol and Ports

& Action Domain

» Profile Applies when a computeris connected to its comporate domain.
& Mame Private

Applies when a computer is connected to a private network location.

Public
Applies when a computer is connected to a public network location.

Leam more about profiles

Rule Wizard — Profile

Select the network(s) that the rule will apply to.
Select Next to continue.

A Name page will allow you to name the rule and add a description for management and organizational
purposes.

Select Finish to save and apply the rule.
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File Action View Help

&= 75 = HE

ﬂ' Windows Firewzll with Advance
B3 Inbound Rules
Outbound Rules
5‘5_.\ Connection Security Rules
> ‘-ﬂ Menitoring

4 (L 2

ﬂ Windows Firewall with Advanced Securiy

Inbound Rules

=
MName il

@Micrnsnf‘t Office Outlook

@Micmsn& OrneMote

@Micmsn& OneMote

@Micrnsnf‘t SharePoint Waorkspace
@Micmsn& SharePoint Workspace
.BranchCache Zontent Retrieval (HTTP-In)
.BranchCache Hosted Cache Server (HTT...
.BranchCache Peer Discovery (WSD-In)
.COM+ Metwork Access (COM-In)
.COM+ Remote Administration (DCOM-In)

Group

m

BranchCache - Conter
BranchCache - Hostec
BranchCache - Peer Di
COM+ Metwork Acces
COM+ Remote &dmir

@Ccre Metworkng - Destination Unreacha... Core Networking
@Ccre Metworkng - Destination Unreacha..  Core Networking
@Ccre Metworking - Dynamic Host Config..  Core Metworking
@Ccre Metworkng - Dynamic Host Config... Core Networking
@Ccre Metworkng - Internet Group Mena...  Core Networking
@Ccre Metworkng - IPHTT?5 (TCP-In) Core Metworking
@f‘rrp Metwnrkng - TPuf (TPufi-Tn) Core Netwarking
@Ccre Metworkng - Multicast Listener De...  Core Networking
@Ccre Metworking - Multicast Listener Qu...  Core Metworking

@f‘rrp Metwnrk ng - Multicast | istener Rep.. Core Netwnrking

(= O ]

Actions

1| mn | 3

Inbound Rules
i3 MewRule..
7 Tilter by Profile 3
NP Filter by State
ST Filter by Group

. .

View
Refresh
Export List...

S

Help

Applied Rules

Repeat for UDP 4900 or TCP 2031.

This will allow thin clients to use port 4900 to download the firmware and allow the thin client to use port
2031 to download the configuration but will keep other ports closed on the firewall.
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28.4.7 Local Security Policy — User Access Controls

You may need to go to the Local Security Policy and change the User Account Control: Behavior of
the elevation prompt for administrators in Admin Approval Mode to Elevate without prompting for
ThinManager to run properly.

Open the Local Security Policy by selecting the Start > Administrative Tools > Local Security Policy.

= Local Security Policy EI@

File Action View Help
= #EIXE = HE

T Security Settings Policy Security Setting =
> (8 Account Policies | Metwork security: Restrict NTLM: NTLM authentication in th..., Mot Defined

| Metwork security: Restrict NTLM: Outgoing MTLM traffic te .. Mot Defined

| Recovery console: Allow automatic administrative logon Disabled

4 [ 4 Local Policies
+ & Audit Policy
+ ' User Rights Assignment

T | Recovery console: Allow floppy copy and access to all drives... Disabled
» g

. [ Windows Firewall with Advanced Sec: | Shutdown: Allow system to be shut down without having to... Disabled

| MNetwork List Manager Policies
: || Public Key Policies
. [ Software Restriction Policies | System cryptography: Use FIPS compliant algorithms for en..  Disabled

| Shutdown: Clear virtual memaory pagefile Disabled
| System cryptography: Force strong key protection for user k.. Mot Defined

. ] Application Contrel Policies | Systern objects: Require case insensitivity for non-Windows ... Enabled
s ,g IP Security Policies on Local Compute | Systern objects: Strengthen default permissions of internal s...  Enabled
- || Advanced Audit Policy Configuration | Systern settings: Opticnal subsystemns Posix

| System settings: Use Certificate Rules on Windows Executabl... Disabled
| User Account Control: Admin Approval Mode for the Built-i...  Disabled
| User Account Control: Allow ULAccess applications to prom...  Disabled

it| User Account Control: Behavior of the elevation prompt for ... Prompt fer consent for ...
| User Account Control Behavior of the elevation prompt for .. Prompt for credentials
| User Account Control: Detect application installations and p.. Enabled

| User Account Control: Only elevate executables that are sign... Disabled
| User Account Control: Only elevate UlAccess applications th.., Enabled

m

| User Account Control: Run all administraters in Admin Appr... Enabled
| User Account Control: Switch to the secure desktop when pr.. Enabled
| User Account Control: Virtualize file and registry write failure... Enabled

1|

4 1l | 3

Local Security Policy — User Account Controls

Highlight Local Policies > Security Options in the tree.

Browse to User Account Control: Behavior of the elevation prompt for administrators in Admin
Approval Mode and change the setting to Elevate without prompting.

This may be needed to run ThinManager as a non-administrator.
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28.5 Command Prompt

Terminal Services has several commands that aid in managing the terminal server. Some useful ones
are:

Command Action
change logon Temporarily disables logons to a Terminal Server
change port Changes COM port mappings for MS-DOS program compatibility
change user /install Puts the server into “Install Mode”
change user /execute Removes the server from “Install Mode”
Ipconfig Displays the IP addresses of the network card
Logoff Logs off a user from a session and deletes the session from the server
net send username “message” Sends a message to a user. username is the NT/2000 user name that the

person or terminal is logged in as. “message” is the text of the message.
Quotation marks are needed for any messages containing a space.

query process Displays information about processes running on a Terminal server
query session Displays information about sessions on a Terminal server

query termserver Displays a list of all Terminal servers on the network

query user Displays information about user sessions on a Terminal server
reset session Resets a session to known initial values

Shadow Monitors another user's session

Tsdiscon Disconnects a client from a terminal server session

Tsshutdn Shuts down the terminal server in an orderly manner

See the Windows online help for additional commands and parameters.

Other useful commands include:

Command Action
gpedit.msc Launches the Group Policy Editor
tscc.msc Launches the Terminal Services Configuration Console
tsadmin Launches the Terminal Services Manager
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28.6 Alternative Terminal Keystrokes

Certain keystrokes are not available in a terminal session. Microsoft has provided these alternatives.

Keystroke

Function

ALT+PAGE UP

Switches between programs from left to right.

ALT+PAGE DOWN

Switches between programs from right to left.

ALT+INSERT Cycles through the programs in the order they were started.
ALT+HOME Displays the Start menu.

CTRL+ALT+BREAK Switches the client between a window and full screen.
CTRL+ALT+END Brings up the Windows 2000 Security dialog box.
ALT+DELETE Displays the Windows menu.

CTRL+ALT+Minus (-) symbol on the
numeric keypad

Places a snapshot of the active window, within the client, on the Terminal server
clipboard (provides the same functionality as pressing PrintScrn on a local
computer.)

CTRL+ALT+Plus (+) symbol on the
numeric keypad

Places a snapshot of the entire client window area on the Terminal server
clipboard (provides the same functionality as pressing ALT+PrintScrn on a local
computer.)
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28.7 DHCP Server Setup

Dynamic Host Configuration Protocol (DHCP) is a program that assigns IP addresses to devices on a
network. DHCP server can be used to provide IP addresses to thin clients. It can also be configured to
point the thin clients to the ThinManager Servers with Option 66, Boot Server Host Name.

28.7.1.1 Scope Options

The DHCP Server needs Option 066 configured before it will provide the ThinManager Server IP address
that the terminal needs to boot.

scopegprons G|

General I Advanced I

Awailable Options | Dezcription :I
O 064 MIS + Domain M ame The name o

O 065 WIS+ Servers A ligt of IP a
(BE Boot Server Host Mame TFTP boot o—
O 067 Bootfile Mame Bootfile Man -
o | o

— Data entry
String walue:

192168.1.1192.168.1.4

ok, I Cancel Apply

Boot Server Host Name

The Boot Server Host Name, Option 066, assigns a ThinManager server to the terminal.

Open the Scope Options dialog box by highlighting the Scope Option folder in the tree pane of the
Computer Management Console under the Services and Application > DHCP folder and selecting
Action > Configure Options.

Scroll through the list window and check the Option 066 check box.
Enter the IP address of the desired ThinManager server in the String Value field.

The DHCP Server can issue the IP address for a Primary ThinManager Server and a Secondary
ThinManager Server by listing the IP addresses of both, separated with a space.
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28.7.1.2 DHCP Properties

The DHCP Server can be configured to check for duplicate IP addresses before issuing a new address.
This is a good feature to use.

Highlight DHCP under Services and Applications in the Computer Management tree and select
Action > Properties, or right-click on DHCP and select Properties. The DHCP Properties window will

launch.
DHCP Properties ﬂ E |

Generall DMW5  Advanced |

Specify the number of times the DHCP zerver should attempt conflict
detection for an [P address before the server leazes the address ta a client.

Conflict detection attempts: g _I

Audit log file path: IE:'\WINDDWS WSoztem32dhop Browsze. .. |
D atabaze path: IE:HWINDEIWS WSeztem3d2ydhop Browse... |
Backup path: II::HWINDEI'W'S SSpstem3Zhdhcpiba Browse... |
Change server connections bindingz: Bindings... |
DMS dunamic updates registration credentials: Credentials... |

ak. I Cancel Apply

DHCP Properties — Advanced Tab

Select the Advanced tab. Replace the zero in the Conflict detection attempts field with an integer. This
will prompt the DHCP Server to check for duplicate IP addresses before assigning an IP address.

Select OK when finished.
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28.8 Group Policy

Windows has a number of features that can be allowed or prevented with a Group Policy. Group Policy is
configured in the Group Policy Object Editor snap-in to the Microsoft Management Console.

Access the Group Policy Editor by typing gped it .msc at a command prompt to launch the Microsoft

Group Policy Editor.
‘i Group Policy Object Editor

File  Action Yiew Help

=] E3

&= | B0RE FE| 2@

=¥ Local Computer Policy
E@ Computer Configuration
-[_] software Settings
-] windows Settings

[ system
G- Mebwork
L[] Prinkers
EI@ ser Configuration
#-(_] Software Settings

I:l Windows Settings

: [ Deskrop
El[:l Control Panel

a Display
‘[0 Prinkers

: (2 Metwork
=-[Z] Swstem

I:l Scripks

[ crrHalk+Del

I:l Logon

E||:| Administrative Templab
-] Windows Compane

[C7 Add or Remove

= Setking

State |

[:IDeskl:up Themes

@ Hide Desktop tab

5% Hide Settings tab
Hide Screen Saver tab

SCreen 5

o]

@ Remave Display in Cankral Panel

@ Present changing wallpaper
@ Hide Appearance and Themes tab

@ Screen Saver executable name
@ Password protect the screen saver

=22 administrative Templat M Screen Saver timeout

[:l Windows Compone
(2] start Menu and Tas

Mak configured
Mok configured
Mok configured
Mok configured
Mok configured
Mak configurad
Mak configured

Mok configured

Mok configured
Mok configured

i Extended ;\ Skandard ,.f"'

| :

Group Policy Settings

Expanding the tree will show Group Policy settings that can affect the terminal server experience.

Please refer to Microsoft documentation for information on using these features.
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28.9 Microsoft Licenses

28.9.1 Microsoft Client Access Licenses (CALS)

Thin Clients require a terminal server with Windows 2003 or 2008 Server with Terminal Services
enabled as an operating system.

Each of these operating systems requires a standard Microsoft Client Access License (CAL) for each
connection to the server. These are based on concurrent use; a 5-pack would allow more than five users
to access server resources, but only five users at a time.

28.9.2 Microsoft Terminal Server Licenses

Terminals, such as thin clients and fat clients, require a license to access terminal services in addition to
the standard Microsoft Client Access License (CAL). This is called the Microsoft Terminal Services
Client Access License (TS CAL) in Windows 2003 and is called the Remote Desktop Services Client
Access License (RDS CAL) in Windows 2008.

Windows 2003 terminal servers require Windows 2003 TS CALs and Windows 2008 terminal servers
require Windows 2008 RDS CALs.

Note: This document will refer to all terminal services CALs as a TS/RDS CALs.

. This licensing is per seat; ten terminals would require ten TS/RDS CALs, even if only two were
connected at a time.

These can be installed as Per Device or Per User.

e The TS/RDS Device CAL licenses one device to connect to any Microsoft Terminal Servers
as any user. This functions like the previous Windows 2000 TS CAL.

e The TS/RDS User CAL licenses one user for any device to connect to any Microsoft Terminal
Servers.

All TS/RDS CALs are installed on a Terminal Services Licensing Server. This acts as a repository for
all TS/RDS CALs. The terminal servers request TS/RDS CAL authentication from the Terminal Services
Licensing Server as terminals attach to terminal servers.

Note: The Terminal Server Licensing Server does not need to be a separate computer. It is a program
that can be installed on any existing server.

The Terminal Services Licensing server is activated through the Internet by connecting to the Microsoft
Certificate Authority and License Clearinghouse.

Windows 2003 and 2008 Servers with Terminal Services enabled will issue 90-day or 120-day temporary
licenses while the Terminal Services Licensing server is being setup and activated. If this period has
elapsed, the terminal will not connect to the terminal server and will display an “Error Number 50”
message box.

Windows Server is not normally sold with TS CALs. These need to purchased separately and installed on
the Terminal Services License server.
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28.9.3 Microsoft Terminal Server Licensing Activation

In Windows 2003 and 2008, all the TS CALs are installed on a single Terminal Server Licensing Server.
This allows a single site for management and authentication of terminal server connections. A server
becomes a Terminal Server Licensing Server by selection of the option during the installation phase or by
selecting Add/Remove Programs > Add/Remove Windows Components from the Control Panel and
selecting the Terminal Services Licensing.

The licensing of the Microsoft components of a Windows 2003 or 2008 terminal server is a two-step
process; one must first authorize the Terminal Server Licensing Server, then one must activate the
licenses. The license activation will be repeated for each license pack.
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